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Ihnen einige grundlegende Hinweise dazu. Eine ausführlichere Aufstellung dazu finden Sie in der 
Hilfedatei des jeweiligen Moduls.

Windows/Linux entspricht am Mac Effekt

Menü-Auswahl Extras ► 
Optionen

LibreOffice ► Einstellungen Zugriff auf die Programmoptionen

Rechts-Klick Control+Klick Öffnen eines Kontextmenüs

Ctrl (Control)

oder Strg (Steuerung)

⌘ (Command) Tastenkürzel in Verbindung mit anderen 
Tasten

Anmerkung für Macintosh Nutzer 3



Inhalt

Anmerkung für Macintosh Nutzer ...................................................................................................  2

Einführung ......................................................................................................................................  6

Die Symbolleiste Zeichnung ...........................................................................................................  6

Allgemeines zum Einfügen von Formen .........................................................................................  8

Einfügen ....................................................................................................................................  8

Varianten des Einfügens ............................................................................................................  9

Mehrfaches Einfügen des gleichen Objekttyps .......................................................................... 9

Einfügen durch Kopieren ...........................................................................................................  9

Einfügen ohne Maus ................................................................................................................  10

Ändern der eingefügten Form ..................................................................................................  10

Formen benennen ...................................................................................................................  11

Technischer Hintergrund ..........................................................................................................  11

Gerade Linien, Pfeile ... ................................................................................................................  12

Zeichnen einer Linie ................................................................................................................  12

Linientyp ..................................................................................................................................  12

Eigenschaften der Linie ...........................................................................................................  13

Maßlinien .................................................................................................................................  13

Kurven und Polygone ...................................................................................................................  13

Freihandlinie ............................................................................................................................  15

Polygone .................................................................................................................................  15

Kurven .....................................................................................................................................  15

Polygone und Kurven ohne Maus ............................................................................................  17

Verbinder .....................................................................................................................................  17

Standardformen ...........................................................................................................................  17

Griffe .......................................................................................................................................  17

Rechteck .................................................................................................................................  18

Abgerundetes Rechteck ..........................................................................................................  18

Quadrat ...................................................................................................................................  18

Abgerundetes Quadrat ............................................................................................................  18

Parallelogramm .......................................................................................................................  18

Trapez .....................................................................................................................................  18

Ellipse ......................................................................................................................................  19

Kreis ........................................................................................................................................  19

Ellipsensektor (Kreissektor) .....................................................................................................  19

Kreissegment ..........................................................................................................................  19

Ellipsenbogen ..........................................................................................................................  19

Halbbogen ...............................................................................................................................  20

Gleichschenkliges Dreieck .......................................................................................................  20

Rechtwinkliges Dreieck ...........................................................................................................  20

Raute .......................................................................................................................................  20

Fünfeck ....................................................................................................................................  20

4 Zeichnen von Formen



Sechseck .................................................................................................................................  20

Achteck ....................................................................................................................................  20

Zylinder ....................................................................................................................................  20

Würfel ......................................................................................................................................  21

Gefaltete Ecke .........................................................................................................................  21

Kreuz .......................................................................................................................................  21

Rahmen ...................................................................................................................................  21

Ring .........................................................................................................................................  21

Symbolformen ..............................................................................................................................  21

Blockpfeile ....................................................................................................................................  22

Flussdiagramme ..........................................................................................................................  23

Legenden .....................................................................................................................................  23

Sterne und Banner .......................................................................................................................  23

3D-Objekte ...................................................................................................................................  23

Text für Formen ............................................................................................................................  24

Anmerkung für Macintosh Nutzer 5



Einführung

Der Hauptzweck von Draw ist es, Zeichnungen zu erstellen, die zweidimensionale geometrische 
Formen (also z. B. Linien, Rechtecke, Ellipsen) enthalten, meist mit ergänzendem Text. Draw kann
auch kompliziertere Dinge wie dreidmensionale Bilder oder Diagramme und abspielbare Medien in 
einem Dokument speichern.

Um all diese unterschiedlichen Formen unter einen gemeinsamen Begriff zu fassen, spricht man 
von Objekten; dies ist ein üblicher Begriff in der Software für Vektorgrafiken.

Dieses Kapitel behandelt die grafischen Grundobjekte von Draw, als da sind Rechtecke, Dreiecke 
Kreise und ähnliche, zum Teil daraus abgeleitete Formen, wie sie von Draw bereits zur Verfügung 
gestellt werden. Wie Sie mit anderen von Draw unterstützten Objekten umgehen können, 
behandeln die folgenden Kapitel dieses Handbuchs.

Die Symbolleiste Zeichnung

Der einfachste Weg zum Einfügen von Formen ist meist die Symbolleiste Zeichnung. Standard-
mäßig sieht sie wie in Abbildung 1 aus.

Abbildung 1: Symbolleiste "Zeichnung"

Sie können die Symbolleiste Zeichnung wie gewohnt abreißen und anderswo auf dm Bildschirm 
platzieren, Näheres finden Sie in im Kapitel 1 Einführung in LibreOffice des Handbuchs Erste 
Schritte.

Die Symbolleiste enthält von links nach rechts in den durch senkrechte Striche abgeteilten Ab-
schnitten die folgenden Werkzeuge. Die Bedeutung eines Symbols sehen Sie auch in der Direkt-
hilfe, die Sie durch Zeigen mit der Maus auf das Symbol, oder, wenn Sie ohne Maus arbeiten, 
durch Betätigen von Strg+F1, wenn das gewünschte Symbol den Fokus hat, anzeigen können.

• Das Auswahlwerkzeug: wenn dieses Werkzeug aktiv ist, können Sie die Objekte durch An-
klicken oder Einrahmen mit der Maus auswählen. Sie benötigen diese Schaltfläche z. B., 
wenn sie vorher eines der Symbole für die Formen dauerhaft eingeschaltet hatten (s.
Mehrfaches Einfügen des gleichen Objekttyps auf Seite 9).

• Werkzeuge für die Färbung der Linie und Fläche

• Werkzeuge für die einfachen Formen: gerade Linie, Rechteck und Ellipse. Diese Werk-
zeuge werden noch einmal angeboten in der Abreißleiste, zu der sie thematisch gehören; 
sie sind nur, weil sie sehr häufig benötigt werden, zum schnelleren Zugriff hier direkt 
aufrufbar.

• Werkzeuge für Objekte, deren Charakteristikum die Linie ist: Pfeile und ähnliches, Kurven 
und Verbinder

• Werkzeuge für zwei- und dreidimensionale Objekte

Die Werkzeuge für die Formen werden in den folgenden Abschnitten detaillierter behandelt. Dabei 
ist zu beachten, dass bei den Symbolen, die durch ein ▼ andeuten, dass durch ihre Betätigung 
eine Palette mit weiteren Symbolen geöffnet wird, normalerweise das zuletzt gewählte Symbol aus
der Palette in der Symbolleiste angezeigt wird; das Bild der Symbolleiste kann also bei Ihnen 
durchaus von dem in Abbildung 1 gezeigten abweichen.
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Die Symbolleiste zeigt aus Platzgründen manchmal nicht alle verfügbaren Befehle an. Durch einen
Rechtsklick mit der Maus auf die Symbolleiste, wenn diese angedockt ist (siehe ganz links in
Abbildung 1), oder einen Klick auf die Schaltfläche▼ am rechten Ende der Kopfleiste einer abge-
rissenen Symbolleiste oder durch die Tastenkombination Umschalt+F10 (wenn ein Symbol 
ausgewählt ist, bei Auswahllisten und Markierfeldern z. B. funktioniert das nicht) können Sie ein 
Menü öffnen, das alle für die Symbolleiste verfügbaren Befehle enthält, die nicht in der Symbol  -  
leiste angezeigt werden, siehe Abbildung 2, das Menü ist aus Platzgründen in drei nebeneinander 
angeordnete Teilstücke aufgeteilt:

• Der erste Abschnitt unter dem Titel erscheint nur deshalb, weil die drei genannten 
Werkzeuge in der Symbolleiste nicht direkt sichtbar waren, weil sie aufgrund der 
Anordnung am linken Bildrand zu kurz für die vollständige Anzeige ist (sie können dann nur
durch Betätigen der Schaltfläche   angezeigt werden).

• Dann folgt die Liste aller prinzipiell verfügbaren Befehle der Symbolleiste, diejenigen, die 
für das ausgewählte Objekt nicht ausführbar sind, sind ausgegraut.

Abbildung 2: Das Menü der Symbolleiste "Zeichnung"

• Der letzte Abschnitt ab dem markierten Befehl, der im Folgenden noch erläutert wird, 
enthält Befehle zur Handhabung der Symbolleiste(n).

◦ Symbolleiste anpassen… führt zum gleichen Dialog wie Extras ► Anpassen ► 
Symbolleisten, der im Kapitel 14 LibreOffice anpassen des Handbuchs Erste Schritte 
beschrieben ist. Dort können Sie auch Befehle in die Symbolleiste einfügen, die von 
LibreOffice nicht dafür vorgesehen sind, beispielsweise auch eigene Makros.

◦ Andocken und Abreißen von Symbolleisten ist allgemein in Kapitel 1 Einführung in 
LibreOffice des Handbuchs Erste Schritte beschrieben.

◦ Das Fixieren einer angedockten Symbolleiste lässt deren Anfasser verschwinden, so 
dass sie nicht mehr abgerissen werden kann.

Der Befehl Sichtbare Schaltflächen ► öffnet ein weiteres Menü, das in Fehler: Verweis nicht 
gefunden wiederum in drei Teile zerschnitten ist.

Hier werden alle für die Symbolleiste verfügbaren Befehle angezeigt, wobei die in der Symbolleiste
sichtbaren mit einem farbigen Quadrat hinterlegt sind. Durch Anklicken/Auswählen können Sie 
einen Befehl in der Symbolleiste anzeigen oder diesen aus ihr entfernen.
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Abbildung 3: Das Untermenü "Sichtbare Schaltflächen der Symbolleiste "Zeichnung"

Allgemeines zum Einfügen von Formen

Einfügen

Hinweis
Dies beschreibt das Einfügen unter Verwendung der Maus. Das Verfahren ohne 
Maus wird in „Einfügen ohne Maus“ auf Seite 10 beschrieben.

Das Grundprinzip des Vorgehens für das Einfügen einer Form ist das folgende:

1. Wählen Sie das Werkzeug für das Zeichnen der Form aus, indem Sie

◦ den Menüpunkt Form ► Einfügen und dann die gewünschte Form wählen oder

◦ das entsprechende Symbol der Symbolleiste Zeichnung auswählen oder

◦ In der Seitenleiste das Blatt Formen wählen oder

◦ in einem der Symbolbänder das entsprechende Symbol auswählen. Die Darstellung mit
Symbolbändern können Sie über Ansicht ► Benutzeroberfläche auswählen, Näheres
dazu finden Sie im Handbuch Erste Schritte im Kapitel Einführung.

(Die Abbildungen in den folgenden Abschnitten beziehen sich meist auf die Symbolleiste 
Zeichnung.)

2. Positionieren Sie den Cursor an der Stelle, an der das Objekt beginnen soll, d.h. den 
Startpunkt einer Linie oder eine Ecke des zwei- oder dreidimensionalen Objekts bzw. bei 
komplizierteren Objekten des dieses einschließenden Rechtecks.

3. Klicken Sie die linke Maustaste und halten Sie sie gedrückt.

4. Bewegen Sie die Maus an den gewünschten Endpunkt der Linie oder den gegenüberlie-
genden Eckpunkt des einschließenden Rechtecks und lassen Sie die Maustaste los.

Im Normalfall werden die Start- und Endpunkte einer Linie bzw. die Ecken des einschließenden 
Rechtecks am Raster „gefangen“, das heißt, dass sie beim Klicken oder Loslassen der Maustaste 
automatisch auf den nächstgelegenen Rasterpunkt verschoben werden. Sie können dieses 
Verhalten ändern, indem Sie Ansicht ► Fanglinien ► Am Raster fangen deaktivieren. Das gilt 
für das aktive Dokument.

Wenn Sie das grundsätzlich ändern wollen, können Sie über Extras ► Optionen ► LibreOffice 
Draw ► Raster ► Am Raster fangen das Verhalten ändern.

Dieses Thema wird vertieft behandelt in Kapitel 3 – Objekte und Objektpunkte dieses Handbuchs.
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Tipp

Ein probates Mittel, um neue Objekte mit gewünschten Eigenschaften zu erzeu-
gen, ist das Kopieren bereits vorhandener passender Objekte. Wählen Sie dazu 
eine Linie oder ein sonstiges Objekt mit passenden Eigenschaften aus, drücken 
Sie Strg+C und dann Strg +V oder äquivalent Kopieren und Einfügen. Das neue 
Objekt ist dann markiert und kann verschoben werden. Oder halten Sie Strg 
gedrückt, während Sie das Objekt „verschieben“, dadurch wird eine Kopie des 
Objekts erzeugt und anschließend verschoben; Voraussetzung dafür ist, dass 
unter Extras ► Optionen ► LibreOffice Draw ► Allgemein ► Einstellungen 
Kopie beim Verschieben aktiviert ist, was standardmäßig der Fall ist.

Varianten des Einfügens
Bei den meisten Typen von Formen können Sie die folgenden Möglichkeiten beim Einfügen 
nutzen:

• Wenn Sie Linien zeichnen wollen, die nur einen Winkel verwenden, der ein Vielfaches von 
45° darstellt (das heißt, anders und etwas salopp ausgedrückt, dass Sie nur waagrechte, 
senkrechte und diagonale Linien zeichnen wollen) oder Formen, deren einschließendes 
Rechteck ein Quadrat ist (also insbesondere, wenn Sie Kreise und Quadrate zeichnen 
wollen), dann halten Sie die Umschalt-Taste beim Ziehen mit der Maus gedrückt.

Hinweis

Das ist das standardmäßige Verhalten von Draw. Sie können das aber umdrehen, 
indem Sie über Extras ► Optionen... ► LibreOffice Draw ► Raster ► Objekte 
beschränken ► Beim Erzeugen und Bewegen den Haken setzen. Dann werden 
standardmäßig 45-Grad-konforme Linien oder quadratisch eingeschlossene Objekte
gezeichnet, abweichendes Verhalten können Sie dann wiederum durch Verwenden 
der Umschalt-Taste erreichen.

Hinweis

In einigen wenigen Fällen ist das Verhalten gerade umgekehrt. Wenn Sie nämlich 
bereits eine spezielle Form eines allgemeinen Typus gewählt haben, also z. B. ein 
Quadrat oder einen Kreis, dann wird bei Verwendung der Umschalt-Taste der allge-
meinere Fall gezeichnet, also im Beispiel ein Rechteck oder eine Ellipse.

• Wenn Sie eine Form mit fixiertem Mittelpunkt zeichnen wollen, dann drücken Sie die Alt-
Taste, während Sie das Objekt zeichnen; es erstreckt sich dann symmetrisch vom Start-
punkt aus, die gewählte Richtung der Mausbewegung bestimmt Höhe und Breite.

• Sie können die Umschalt- und die Alt-Taste auch kombinieren

Mehrfaches Einfügen des gleichen Objekttyps
Wenn Sie in der Symbolleiste Zeichnung ein Werkzeug ausgewählt und dann die gewünschte 
Form gezeichnet hatten, ist automatisch wieder das Auswahl-Werkzeug aktiviert, was in vielen 
Fällen auch das passende Verhalten ist. Wenn Sie allerdings mehrere Formen des gleichen 
Objekttyps nacheinander einfügen wollen, klicken Sie einfach vor dem ersten Einfügen ein zweites 
Mal auf das Symbol. Dadurch ist es permanent aktiviert. Sie können die permanente Aktivierung 
beenden durch einen Klick auf das Auswahl-Symbol der Symbolleiste oder die Esc-Taste.

Einfügen durch Kopieren
Bequem können Sie ein Objekt einfügen, wenn die Zeichnung bereits ein ähnliches enthält, indem 
Sie dieses kopieren.
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Die schnellste Möglichkeit ist, die Strg-Taste gedrückt zuhalten, während Sie ein Objekt anklicken 
und dann die Maus verschieben: es wird eine Kopie erzeugt, die verschoben wird, bis Sie die 
Maustaste loslassen.

Eine andere Möglichkeit, insbesondere auch für das Kopieren von einem Dokument in ein ande-
res, besteht in der Verwendung von Strg+C und Strg+V (oder der Befehle Kopieren und Einfügen
aus dem Bearbeiten-Menü); die Kopie liegt dann an der gleichen Position wie die Quelle, und 
somit, wenn Sie sie auf der gleichen Folie einfügen, exakt über der Quelle. Dieses Verfahren ist 
insbesondere günstig, wenn das kopierte Objekt in waagrechter oder senkrechter Richtung 
genauso ausgerichtet sein soll wie die Quelle, weil Sie dann die Verschiebung in der dazu 
senkrechten Richtung anschließend einfach mit den entsprechenden Pfeiltasten ausführen 
können.

Auch mit Hilfe des Navigators (s. Kapitel 3 – Objekte und Objektpunkte dieses Handbuchs) können
Sie Objekte kopieren: Ziehen Sie das Objekt aus dem Navigator auf die gewünschte Folie, es wird 
eine Kopie erzeugt. Dieses Verfahren können Sie auch für das Kopieren von einem Dokument in 
ein anderes nutzen, innerhalb eines Dokuments funktioniert es nur beim Kopieren auf die gleiche 
Folie.

Für das Kopieren auf andere Seiten benötigen Sie auf jeden Fall diese Tastenkombinationen oder 
Menübefehle.

Einfügen ohne Maus
1. Aktivieren Sie durch mehrmaliges Betätigen von F6 (oder Umschalt+F6 für die umgekehrte 

Durchlaufreihenfolge) die Symbolleiste Zeichnung. Leider ist meist nicht direkt erkennbar, 
ob sie gerade aktiviert ist, weil das erste Symbol Auswahl ohnehin aktiviert ist, sie können 
es prüfen, indem Sie zum nächsten Symbol navigieren (s. Punkt 2 dieser Liste). Am besten 
ist es, sich die notwendige Reihenfolge zu merken.

2. Navigieren Sie zum gewünschten Symbol mit der Tab- oder Umschalt+Tab-Taste (für die 
rückläufige Reihenfolge) oder mit den Pfeiltasten Nach rechts und Nach links bei einer 
horizontalen Symbolleiste bzw. Nach unten und Nach oben bei einer vertikalen.

3. Wenn das Symbol ein aufklappbares Untermenü hat, dann öffnen Sie dieses durch 
Nach rechts bei einer vertikalen Symbolleiste bzw. Nach unten bei einer horizontalen.

4. Durch Strg+Eingabe wird ein Zeichnungsobjekt der gewünschten Form mit Standardmaßen
mittig auf der Seite platziert.

5. Setzen Sie durch Strg+F6 den Fokus auf das Dokument, damit Sie das Objekt bearbeiten 
können.
Andernfalls ist der Fokus noch auf der Symbolleiste, was Sie nutzen können, wenn Sie 
gleich noch weitere Zeichnungsobjekte erzeugen wollen.

Hinweis
Weitere Informationen zum Navigieren in Menüs, Symbolleisten usw. werden auch 
im Anhang A – Tastaturkürzel des Handbuchs Erste Schritte geboten.

Ändern der eingefügten Form
Sie können natürlich die Eigenschaften der gerade eingefügten Form jederzeit beeinflussen. Die 
dazu notwendigen Informationen finden Sie in Kapitel 3 – Objekte und Objektpunkte, was eher die 
geometrischen Eigenschaften betrifft, bzw. in Kapitel 4 – Objekte formatieren dieses Handbuchs 
für die restlichen Eigenschaften.
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Formen benennen
Eine eingefügte Form erhält – wie auch andere eingefügte Objekte – zwar einen von LibreOffice 
vergebenen Namen, der aber bei Formen einfach aus „Form“ und einer laufenden Nummer be-
steht. Sie können über Format ► Namen… dem Objekt stattdessen einen aussagekräftigen Na-
men geben. In vielen Fällen wird dies zwar nicht nötig sein, aber wenn Sie den Navigator (s. Kapi-
tel 3 – Objekte und Objektpunkte dieses Handbuchs) benutzen wollen, um Objekte zu selektieren, 
dann ist das Voraussetzung, das funktioniert nicht mit den vom System vergebenen Namen.
Auch wenn Sie per Programm auf die Objekte zugreifen wollen, ist ein sprechender Name notwen-
dig, Programmierung ist allerdings nicht das Thema dieses Handbuchs.

Technischer Hintergrund
Zum Teil aufgrund ihrer konstruktiven Eigenschaft, zum Teil aber auch aus der historischen Ent-
wicklung heraus basieren die Formen auf verschiedenen technischen Konzepten, deren Auswir-
kungen Ihnen oft verborgen bleiben werden, die sich aber manchmal doch am Verhalten zeigen.

Als grundlegende Typen gibt es Linie, Rechteck und Ellipse, daneben aufgrund gänzlich anderer 
Konstruktionsgrundlagen Bézierkurven und Polygone.

Um komplexere Formen anbieten zu können, wurde ein allgemeineres Konzept realisiert, die intern
Custom Shapes (etwa „maßgeschneidert“ oder „passgenau“) genannten Formen, der Begriff 
taucht an der Oberfläche nicht auf; dadurch wurden Formen wie die in Abbildung 4 gezeigten 
möglich. Das hat auch den Vorteil, dass Entwickler weitere Formen zur Verfügung stellen können, 
die Sie über die Gallery (s. Kapitel  11 – Grafik, Gallery und Fontwork des Handbuchs Erste 
Schritte oder auch Kapitel 11 – Weiterführende Themen dieses Handbuchs) oder per Ziehen und 
Ablegen bequem verwenden können.

Abbildung 4: Einige Beispiele für Custom Shapes

Als Konsequenz werden nun auch die von Rechteck und Ellipse abgeleiteten Formen im Wesent-
lichen als Objekte auf dieser Basis angeboten; die entsprechenden Objekte, die mit der älteren 
Technik arbeiten, sind über die Symbolleisten Rechtecke (veraltet) und Kreise und Ellipsen (veral-
tet) weiter verfügbar, werden aber standardmäßig nicht angeboten, wie auch der Hinweis im 
Namen nahelegt. Sie können diese Symbolleisten über Ansicht ► Symbolleisten bei Bedarf 
aktivieren.

Eine Ausnahme bilden zwei Symbole, die auch in der Symbolleiste Standardformen enthalten sind,
nämlich Kreissegment (siehe S. 19) und Ellipsenbogen(s. S. 19), für die es offenbar keine Realisie-
rung als „Custom Shape“ gibt. Sie verwenden noch die ältere Technik und finden sich genauso in 
der veralteten Symbolleiste.

Ein für die Handhabung relevanter Unterschied besteht darin, dass bei Custom Shapes die Griffe 
sichtbar sind, sobald das Objekt selektiert ist, bei den mit der älteren Technik realisierten dagegen 
dafür die Aktivierung der Option Punkte (über Bearbeiten ► Punkte, F8 oder das Symbol der 
Symbolleiste Standard) nötig ist.
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Gerade Linien, Pfeile ...

Dieser Begriff beinhaltet sowohl einfache Linien ohne Besonderheit an den Endpunkten wie auch 
Pfeile und andere Linien mit Linienspitzen. Sie können die Linienspitzen einer Linie später jederzeit
ändern, daher ist es – bis auf wenige Ausnahmen – auch ziemlich egal, ob Sie mit einer einfachen 
Linie oder einem der Typen beginnen, die über das Symbol Linien und Linienspitzen (siehe unten) 
angeboten werden.

Zeichnen einer Linie
Das Grundprinzip des Vorgehens wurde bereits in „Einfügen“ auf Seite 8 beschrieben.

Der Startpunkt der Linie ist mit einem etwas größeren, der Endpunkt mit einem etwas kleineren 
Quadrat markiert (Abbildung 5).

Abbildung 5: Linie mit Start- und Endpunkt

Linientyp
In der Symbolleiste Zeichnung können Sie eine einfache Linie ohne besondere Linienenden direkt 
über das Symbol Linie einfügen einfügen oder über die Abreißleiste Linien und Linienspitzen. Im 
zweiten Fall konnten Sie bereits aus einem Angebot verschiedener Linientypen wählen, das einige 
häufig benötigte Kombinationen der Linienspitzen für Anfang und Ende bereitstellt. Abbildung 6 
zeigt links die Abreißleiste im angedockten und rechts im abgerissenen Zustand.

Abbildung 6: Symbolleiste Linien und Linienspitzen angedockt (links) und abgerissen (rechts)

Im abgerissenen Zustand zeigt die Abreißleiste leider den einschränkenden Titel „Pfeile“.

Der Vorteil der abgerissenen Palette ist, dass sie geöffnet bleibt; Sie können das ausnutzen, wenn 
Sie eine größere Anzahl von Linien zeichnen möchten. Irgendwann ist die Palette dann wahr-
scheinlich im Weg, schließen Sie sie dann einfach, sie können später wieder die angedockte 
Palette durch Anklicken des Symbols in der Symbolleiste Zeichnung öffnen.

Das angezeigte Symbol für Linien und Linienspitzen in der Symbolleiste Zeichnung (links oben im 
linken Bild in Abbildung 6) ändert sich übrigens je nach der letzten von Ihnen vorgenommenen 
Auswahl; der Standard bei einem neuen Dokument ist der Pfeil, wie er links oben im rechten Bild in
Abbildung 6 gezeigt wird. Das ermöglicht Ihnen, bei angedockter Palette den zuletzt ausgewählten 
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Typ der Linie durch einfaches Anklicken des Symbols zu wählen, ohne die Palette öffnen zu 
müssen.

Eigenschaften der Linie
Eine erzeugte Linie hat zunächst die standardmäßig festgelegten Eigenschaften. Diese können 
Sie, abgesehen vom Linientyp, über das Symbol Linien und Linienspitzen der Symbolleiste 
Zeichnung, auch nicht beeinflussen. Sie können aber anschließend die erzeugte Linie selektieren 
und über Kontextmenü ► Eigenschaften, über Format mit seinen diversen Untermenüs oder 
über die Seitenleiste (sie wird im Kapitel 1 des Handbuchs Erste Schritte näher beschrieben) ihre 
Eigenschaften verändern.

Insbesondere ermöglichen Format ► Linie, Kontextmenü ► Linie oder der entsprechende 
Abschnitt der Seitenleiste die Veränderung der linienspezifischen Eigenschaften.

Maßlinien
Ein Sonderfall der Linie ist die Maßlinie (Abbildung 7).

Abbildung 7: Maßlinien

Sie dient dazu, die Dimensionen eines Objekts anzuzeigen, die Zahlengabe wird automatisch von 
LibreOffice berechnet.

Einzelheiten zu Maßlinien finden Sie in Kapitel 12 – Weiterführende Themen zu Zeichnungsobjek-
ten dieses Handbuchs.

Kurven und Polygone

Abbildung 8 zeigt die abgerissene Symbolleiste für Kurven und Polygone und deren Erläuterung. 
Die beiden Begriffe werden nicht ganz einheitlich verwendet: in der Statusleiste wird für offene 
Linienzüge der Begriff Vielfachlinie angezeigt, für geschlossene der Begriff Polygon, der anderer-
seits in der Abreißleiste sowie im Menü und der Seitenleiste durchgängig verwendet wird.
Die Handhabung in der Statusleiste ist die korrektere.

Abbildung 8: Symbolleiste Kurven und Polygone (abgerissen)
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Die Objekte dieser Symbolleiste können jeweils gefüllt oder ungefüllt sein; präziser gesagt:

• ein gefülltes Objekt ist geschlossen und hat eine Füllung

• ein ungefülltes Objekt ist (zunächst) nicht geschlossen und hat keine Füllung

Den Unterschied zeigt Abbildung 9:

Abbildung 9: ungefüllt und gefüllt

Sie zeigt den gleichen Linienzug, links „ungefüllt“, rechts „gefüllt“. Bei einem gefüllten Objekt wird 
immer die Linie vom derzeitigen Endpunkt (unten) zum Anfangspunkt (oben) automatisch mitge-
führt (die rote Linie im rechten Bildteil).

Hinweis
Auch nicht geschlossene Objekte können in manchen Fällen gefüllt werden, 
beispielsweise die Klammern, die bei den Symbolformen zu finden sind.

Ein ungefülltes Objekt kann man schließen, indem man Kontextmenü ► Objekt schließen auf-
ruft. Dann wird im Beispiel der Abbildung 9 die rote Linie ergänzt. Bei komplizierteren Linienführun-
gen können sich dabei durchaus erstaunliche Ergebnisse zeigen. Die zugrundeliegende Regel 
wird im Abschnitt Kombinieren des Kapitel 5 – Behandlung mehrerer Objekte dieses Handbuchs 
erläutert. Anschließend können Sie es auch füllen über Kontextmenü ► Fläche.. oder Format ► 
Fläche.. .

Vorsicht

Versuchen Sie nicht, das Objekt selbst beim Zeichnen zu schließen, indem Sie das 
letzte Liniensegment zum Anfangspunkt zurückführen; es wird zwar, wenn Sie sich 
dabei dem Anfangspunkt genügend nähern, automatisch geschlossen, in aller Regel
wird aber ein weiteres, ziemlich kleines Segment ergänzt, weil Sie wahrscheinlich 
den Ausgangspunkt nicht exakt treffen werden. Abbildung 10 zeigt links einen 
solchen Fall, nur bei genauem Hinsehen entdeckt man eine kleine Unregelmäßigkeit
in der linken oberen Ecke, die starke Vergrößerung rechts zeigt die Ursache, zwei 
nahe beieinander liegende Punkte.

Abbildung 10: manuell geschlossenes Polygon

Sie können ein ungefülltes Objekt erhalten, indem Sie der Fläche die Art der Füllung ohne 
zuweisen.
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Freihandlinie
Die Handhabung ist sehr einfach, aber es ist nicht unbedingt leicht, das gewünschte Ergebnis zu 
erzielen, weil die Bewegung mit der Maus gut gesteuert werden muss.

1. Wählen Sie den entsprechenden Menüpunkt oder das entsprechende Symbol.

2. Klicken Sie am Startpunkt der Linie.

3. Zeichnen Sie mit dem Cursor die Begrenzungslinie der gewünschten Form.

4. Doppelklicken Sie, wenn Sie den Endpunkt erreicht haben.

Polygone
Dies umfasst die Fälle Polygon und Polygon (45°), jeweils gefüllt und ungefüllt. Die Fälle mit (45°) 
unterscheiden sich von den anderen beiden nur dadurch, dass der Winkel der erzeugten Linien 
immer ein Vielfaches von 45° beträgt, was häufig eine Erleichterung beim Zeichnen von Formen 
bedeutet.

Um ein solches Polygon zu zeichnen:

1. Wählen Sie den entsprechenden Menüpunkt oder das entsprechende Symbol.

2. Klicken Sie am Startpunkt des ersten Segments des Polygons.

3. Ziehen Sie bei gedrückter Maustaste den Cursor zum Endpunkt des ersten Segments: eine
Linie wird gezeichnet.

4. Lassen Sie die Maustaste los.

5. Bewegen Sie den Cursor zum gewünschten Endpunkt des nächsten Segments: eine 
weitere Linie wird gezeichnet.

6. Klicken Sie, um den Endpunkt zu fixieren, und wiederholen Sie Schritt 5, wenn Sie weitere 
Segmente zeichnen wollen, oder doppelklicken Sie, um das Zeichnen des Polygons 
abzuschließen.

Hinweis
Die Statusleiste zeigt an, dass es sich um eine Vielfachlinie bzw. ein Polygon 
handelt, und nennt die Anzahl der Punkte.

Kurven
Die Kurven, die mit diesem Werkzeug gezeichnet werden, sind Bézierkurven; hier wird zunächst 
nur das Zeichnen einer solchen Kurve (ohne Füllung) gezeigt, um die Übersicht der verfügbaren 
Formen vollständig zu machen, Näheres zur Arbeit mit Bézierkurven finden Sie in Kapitel 12 – 
Weiterführende Themen zu Zeichnungsobjekten dieses Handbuchs.

Abbildung 11 zeigt den Ablauf des Zeichnens einer solchen Kurve und einer ersten Änderung. Erst 
der zweite und dritte Schritt lassen erkennen, warum die Linie im ersten Schritt so gezogen wurde.
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Abbildung 11: Zeichnen einer Kurve

a) Ziehen Sie eine waagrechte Linie, indem Sie bei  klicken und die Maustaste halten und 
bei  die Taste loslassen

b) Bewegen Sie die Maus nach links unten (der rot angedeutete Pfeil zeigt die Cursor-
bewegung), damit Sie an dem Punkt anlangen, wie die zweite Grafik der Abbildung das 
zeigt. Doppelklicken Sie dann, damit die Kurve abgeschlossen wird.

c) Der dritte Teil der Abbildung zeigt nun die Struktur der erzeugten Kurve: Beginn und Ende 
der Kurve haben als Tangente die Geraden, die von den Anfangs- und Endpunkten zu dem 
Punkt  verlaufen. Es ist eine der Charakteristiken der Bézierkurven, dass das Verhalten 
an ihren Endpunkten durch Tangenten bestimmt ist.

d) Die Kurve ist nun ein flächiges Objekt. Wenn Sie sie anklicken, dann erscheinen acht 
Bearbeitungspunkte, die das umfassende Rechteck repräsentieren; Sie können dann die 
Breite und Höhe der Kurve verändern (s. Kapitel 3 – Objekte und Objektpunkte). Wenn Sie 
jedoch die Form der Kurve verändern wollen, dann müssen Sie über Kontextmenü ► 
Punkte oder über die Symbolleiste Standard und das Symbol Punkte oder die Taste F8 die 
Bearbeitung der Punkte der Kurve einschalten.
Zunächst zeigt der Cursor, wenn der Mauszeiger sich einem Endpunkt nähert, als Symbol 
den Pfeil und ein Quadrat als Zeichen, dass der Punkt verschoben wird, wenn Sie ihn 
anklicken und die Maus bewegen.
Wenn Sie allerdings i.  A. einen Endpunkt der Kurve anklicken und die Maustaste loslas-
sen, erscheint ein durch einen  Kreis symbolisierter Punkt mit einer Linie zu diesem End-
punkt; dies zeigt Teil d) dieser Abbildung. Der Endpunkt dieser Linie (bei ) wird Steuer-
punkt genannt, weil er das Verhalten der Kurve in diesem Endpunkt steuert.
Durch eine Änderung der Richtung dieser Linie ändert sich die Austrittsrichtung der Kurve, 
die Länge der Linie bestimmt die Krümmung.

e) Bei der neu erzeugten Kurve ist der Endpunkt (nun im Sinne des Zeichnens: das „Ziel“, das
durch ein kleineres Quadrat gekennzeichnet ist) – im Gegensatz zum Anfangspunkt – zu-
nächst einmal scheinbar ohne Steuerpunkt. Das liegt daran, dass die Kurve aufgrund ihrer 
Entstehung nur einen Steuerpunkt besitzt; Sie haben ja nur durch das Klicken an der mit  
markierten Stelle einen Punkt gesetzt. Damit auch die Möglichkeit besteht, das Verhalten 
der Kurve in diesem Endpunkt zu verändern, ist ein zweiter Steuerpunkt vorgesehen. Er 
liegt allerdings genau auf dem Endpunkt, was man bei genauem Hinschauen auch bemer-
ken kann: vergrößern Sie das Dokument, dann können Sie sogar in der Abbildung erken-
nen, dass vor dem hellbraun gezeichneten Quadrat ein blauer Kreis liegt. Wenn Sie auf 
diesen Endpunkt zeigen, ändert sich das Cursor-Symbol zu dem, das auch noch in der 
Abbildung zu sehen ist, was bedeutet, dass Sie es mit einem Steuerpunkt zu tun haben; 
wenn Sie nun mit gedrückter Maustaste die Maus bewegen, wird die zugehörige Linie 
sichtbar, und Sie können die Richtung, mit der die Kurve den Endpunkt verlässt, sowie die 
Form der daraus resultierenden Kurve bestimmen.
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Wenn Sie in b) nicht doppelklicken, können Sie die Kurve weiter zeichnen, wie Sie damit weiter 
umgehen können, finden Sie in Kapitel 12 – Weiterführende Themen zu Zeichnungsobjekten 
dieses Handbuchs.

Polygone und Kurven ohne Maus
Wenn Sie wie in „Einfügen ohne Maus“ auf Seite 10 beschrieben ein Polygon oder eine Kurve 
ohne Verwendung der Maus einfügen, wird die eingefügte Standardform sicher nicht Ihren Wün-
schen entsprechen. Zum Ändern der Form müssen Sie dann die Werkzeuge für Bézierkurven 
verwenden, die im Kapitel Kapitel 12 – Weiterführende Themen zu Zeichnungsobjekten 
beschrieben sind.

Verbinder

Verbinder werden in Kapitel 8 – Verbinder, Fluss- und Organisationsdiagramme im Zusammen-
hang mit Klebepunkten beschrieben.

Standardformen

Dieses Werkzeug bietet eine Vielzahl von etwas komplizierteren Formen, zum Teil mit Möglichkei-
ten zur weiteren Beeinflussung des Aussehens, wie sie bei Rechteck und Ellipse gar nicht 
auftreten (Abbildung 12).

Die einzelnen Symbole werden im Folgenden entsprechend der Darstellung in Abbildung 12 
spaltenweise von oben nach unten beschrieben; in der Abreißleiste entspricht das der Reihenfolge
von links nach rechts in Zeilen.

Die allgemeine Größenänderung erfolgt wie üblich über die acht Begrenzungspunkte des die Form
umgebenden Rechtecks (vier Eckpunkte, vier Seitenmittelpunkte) in Form kleiner Quadrate.

Abbildung 12: Die Werkzeuge der Symbolleiste "Standardformen"

Griffe
Viele der Formen enthalten neben diesen Begrenzungspunkten noch einen oder zwei Griffe, die 
durch graue Kreise kenntlich gemacht werden. Sie ermöglichen die Änderung weiterer Parameter 
der Form, wie Eckenradius, Öffnungswinkel usw. Manche dieser Griffe ändern den Parameterwert 
um einen festen Wert abhängig von der Verschiebung des Griffes, andere tun dies proportional zu 
den Dimensionen des umschließenden Rechtecks; daher ändert der Griff im ersten Fall eventuell 
seinen Platz, wenn das Verhältnis zwischen Breite und Höhe des umgebenden Rechtecks sich 
ändert.

Ohne Maus können Sie die Griffe erreichen, indem Sie solange Strg+Tab oder Strg+Umschalt+Tab
betätigen, bis der Griff blinkt; der Weg mit Tab durchläuft zuerst alle Punkte des Rechtecks und 
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dann den zusätzlichen Griff, der Weg mit Umschalt+Tab beginnt beim Griff. Bewegen Sie dann den
Griff mit den Pfeiltasten.

In manchen Fällen (wenn es sich nicht um ein Custom Shape handelt) sehen Sie die Griffe nur, 
wenn Sie den Punktmodus einschalten über den Menüpfad Bearbeiten ► Punkte, das Symbol 
Punkte aus der Symbolleiste Standard oder F8.

Rechteck
Zeichnet ein Rechteck, bei zusätzlicher Verwendung der Umschalt-Taste wird ein Quadrat 
gezeichnet.

Abgerundetes Rechteck
Im Vergleich zum Rechteck besitzt dieses Objekt einen zusätz-
lichen Griff (Kreis), auf den das geänderte Cursorsymbol der 
Hand in der Abbildung deutet, mit dem Sie die Größe der Ab-
rundung der Ecke beeinflussen können. Der Griff befindet sich 
entweder auf der oberen oder auf der linken Kante des Recht-
ecks, je nachdem, welche von beiden länger ist. Bewegen Sie 
diesen Griff mit der Maus, um die Größe der Abrundung zu 
verändern.

Über Kontextmenü oder Format ► Position und Größe ► 
Schrägstellen/Eckenradius lässt sich der Eckenradius 

ebenfalls festlegen. Dazu wird allerdings nicht das Feld Eckenradius verwendet, das nur für 
Formen vom alten Typus (s. „Technischer Hintergrund“ auf Seite 11) aktiv ist, sondern er wird über 
die Felder zum Kontrollpunkt 1 gesteuert, wie Sie ja auch diesen Kontrollpunkt mit der Maus 
verschieben. Sie geben hier in der Variablen X oder Y (nur die zutreffende ist aktiv) den Abstand 
des Kontrollpunkts vom Eckpunkt an, was gleichzeitig auch der Radius der Rundung ist.

Quadrat
Zeichnet ein Quadrat, bei zusätzlicher Verwendung der Umschalt-Taste wird ein Rechteck 
gezeichnet.

Abgerundetes Quadrat
Das Verhalten ist das gleiche wie in Abgerundetes Rechteck auf Seite 18.

Parallelogramm
Das Verhalten ist ganz ähnlich wie in Abgerundetes Rechteck auf Seite 18, bloß bewirkt die 
Verschiebung des Griffs hier die Veränderung der Neigung des Parallelogramms. Um ein zur 
anderen Seite geneigtes Parallelogramm zu erhalten, spiegeln Sie es.

Trapez
Das Verhalten ist ganz ähnlich wie in Abgerundetes Rechteck auf Seite 18, bloß bewirkt die 
Verschiebung des Griffs hier die Veränderung der Breite der (schmäleren) Basis des Trapezes und
damit natürlich auch der Neigung von dessen Seiten. Die Breite der oberen Kante können Sie ein-
fach über die standardmäßigen Objektpunkte des umrahmenden Rechtecks verändern. Sie kön-
nen die hier schmälere Basis nicht über die Größe der breiteren oberen Kante hinaus verlängern; 
wenn Sie die breitere Basis unten benötigen, spiegeln Sie einfach das Trapez vertikal.
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Ellipse
Zeichnet eine Ellipse, bei zusätzlicher Verwendung der Umschalt-Taste wird ein Kreis gezeichnet.

Kreis
Zeichnet einen Kreis, bei zusätzlicher Verwendung der Umschalt-Taste eine Ellipse.

Ellipsensektor (Kreissektor)
Der Name dieses Symbols ist in der deutschen Fassung in dieser 
Version von LibreOffice noch falsch, er muss Kreissektor lauten.

Über den beiden Seitenmittelpunkten oben und rechts liegen Griffe, mit 
denen Sie die Öffnung der Kreisfläche verändern können.

Wenn Sie beim Erzeugen der Form die Umschalt-Taste zusätzlich 
gedrückt halten, wird ein Ellipsensektor erzeugt.

Sie können die beiden Griffe theoretisch auch über Kontextmenü ► 
Position und Größe ► Schrägstellen/Eckenradius verändern: für 

jeden der beiden Punkte ist die x- und y-Koordinate angegeben. Es lässt sich jeweils nur eine der 
beiden verändern, das hängt davon ab, in welcher der beiden Hälften (bezüglich der 45°-Linie) 
eines Viertelkreises sich der Punkt befindet.

Wenn Sie einen möglichst exakten Winkel erreichen wollen, empfiehlt es sich, zunächst eine 
radiale Hilfslinie zu zeichnen (beim Zeichnen wird der Winkel in der Statusleiste angezeigt) und 
dann bei ziemlich großer Vergrößerung den Griff auf dieser Hilfslinie platzieren.

Kreissegment
Hier zeichnen Sie zunächst einen Kreis in der gewünschten 
Größe; wenn Sie diese Phase durch einen Klick abschließen, 
wird der Kreis in der Form, wie sie im linken Teil,der Abbildung 
sichtbar ist, dargestellt. Die angezeigte radiale Linie wird durch 
die Cursorbewegung verschoben, wobei der Mauszeiger sich 
nicht auf der Kreislinie befinden muss, es kommt nur auf die 

Richtung zum Mittelpunkt an. Während Sie die Maus bewegen, wird in der Statusleiste der 
jeweilige Winkel angezeigt.Wenn Sie klicken (im Beispiel wurde der am weitesten rechts liegende 
Punkt des Kreises gewählt), wird da, wo diese radiale Linie auf den Rand des Kreises trifft, wird 
der Anfangspunkt des Kreissegments gesetzt. Bewegen Sie nun den Cursor, um den zweiten 
Punkt zu bestimmen, der das Segment festlegt, und klicken Sie erneut. Das Ergebnis ist eine 
Form, wie sie im rechten Teil der Abbildung erscheint. Das übrigbleibende Segment ist der Teil des 
Kreises rechts von der Linie zwischen dem Anfangspunkt und diesem zweiten Punkt, wenn die 
Linie in dieser Richtung durchlaufen wird.

Auch in diesem Fall wird ohne Umschalt-Taste ein Kreis gezeichnet, mit  Umschalt-Taste eine 
Ellipse.

Diese Form basiert auf der älteren Technik, daher müssen Sie den Punktmodus einschalten (s. 
„Griffe“ auf Seite 17), um die Griffe zum Anpassen des Segments zu sehen.

Ellipsenbogen
Hier gilt das gleiche Vorgehen wie in Kreissegment auf Seite 19, nur dass das Ergebnis ein 
Abschnitt auf der Ellipsenlinie ist. Die Umschalt-Taste verhält sich hier wieder wie in Varianten des 
Einfügens auf Seite 9 beschrieben.
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Diese Form basiert genau wie die vorige auf der älteren Technik, das dort Gesagte gilt 
entsprechend

Halbbogen
Dieser Befehl erzeugt einen Halbbogen, der entsprechend dem Verhältnis von Höhe und Breite 
des dieses Objekt umrahmenden Rechtecks dargestellt wird. Der zusätzlich Griff ermöglicht 
sowohl, die Breite des Bogens festzulegen (waagrechte Komponente), als auch zu bestimmen, wie
weit der Bogen geöffnet oder geschlossen ist (senkrechte Komponente).

Gleichschenkliges Dreieck
Dieser Befehl erzeugt ein gleichschenkliges Dreieck. Der Griff oben in der Mitte erlaubt es, die 
obere Ecke zu verschieben (wodurch das Dreieck natürlich nicht mehr gleichschenklig ist).

Rechtwinkliges Dreieck
Erzeugt ein rechtwinkliges Dreieck, bei Einsatz der Umschalt-Taste ein gleichschenklig-rechtwink-
liges Dreieck, also ein diagonal halbiertes Quadrat.

Raute
Der Befehl erzeugt eine Raute, bei Einsatz der Umschalt-Taste eine mit rechten Winkeln, was das 
selbe wie ein auf der Spitze stehendes Quadrat ist.

Fünfeck
Der angegebene Titel ist zwar „regelmäßiges Fünfeck“, aber auch bei Verwendung der Umschalt-
Taste wird nur ein Fünfeck erzeugt, dessen umschließendes Rechteck ein Quadrat ist. Ansonsten 
entsteht ein Fünfeck, bei dem die waagrechte und die senkrechte Ausdehnung sich unterscheiden.

Sechseck
Das Verhalten ist genauso wie beim Fünfeck. Das Sechseck enthält zusätzlich noch einen Griff, 
mit dem sich der Winkel der nicht waagrechten Kanten verändern lässt.

Achteck
Auch dieses verhält sich ähnlich wie das Sechseck. Der Griff bewirkt hier, ähnlich wie beim abge-
rundeten Rechteck und Quadrat, eine Änderung der Größe der „abgeschnittenen Ecken“.

Zylinder
Erzeugt einen stehenden Zylinder (in isometrischer Darstellung). Der Griff ermöglicht es, die 
Neigung der Draufsicht zu verändern.
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Würfel

Abbildung 13: Verformung eines Quaders in Richtung der drei Achsen

Ein Würfel wird nur bei Verwendung der Umschalt-Taste erzeugt (oder wenn das umgebende 
Rechteck ein Quadrat ist), ansonsten ist es im Allgemeinen ein Quader. Der Winkel, mit dem die 
z-Achse dargestellt wird, beträgt 45°. In Richtung der x- und y-Achse kann man den Quader 
verlängern oder verkürzen, indem man einen der acht Eck- und Seitenmittelpunkte verschiebt, der 
zusätzliche Griff verändert die Größe der Stirnfläche, der Quader erscheint in Richtung der 
z-Achse damit im Verhältnis zur Stirnfläche länger oder kürzer (Abbildung 13).

Gefaltete Ecke
Der Befehl erzeugt das Bild eines Blattes mit umgeklappter Ecke, der Griff ermöglicht die Größen-
änderung der Ecke.

Kreuz
Der Befehl erzeugt eine kreuzförmige Fläche, der Griff dient dazu die Breite der Kreuzarme zu 
verändern. Die waagrechten und die senkrechten Arme werden beide um den gleichen Wert 
verbreitert oder verschmälert, maximal, bis die Dimension mit dem schmäleren Arm die Breite 0 
erhält.

Rahmen
Der Befehl zeichnet einen rechteckigen Rahmen, der Griff ermöglicht es, dessen Breite zu 
verändern.

Ring
Der Befehl zeichnet einen Ring, dessen Breite durch den Griff verändert werden kann. Hier wird 
wieder ohne Umschalt-Taste ein Kreisring, mit dagegen ein Ellipsenring gezeichnet. Die Größen-
änderung des Rings erfolgt proportional zur Höhe bzw. Breite, daher muss der Griff seinen Platz 
nicht wechseln.

Symbolformen

Dieses Werkzeug bietet die in Abbildung 14 dargestellten Symbolformen an.
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Abbildung 14: Das Werkzeug "Symbolformen"

Die Mehrzahl der Formen besitzt auch wiederum Griffe, deren Funktion ähnlich wie bei den Stan-
dardformen ist (s. Griffe auf Seite 17 und die eventuellen Ergänzungen bei den einzelnen Stan-
dardformen).

Da auch das sonstige Verhalten dem der Standardformen vergleichbar ist, werden die Symbol-
formen nicht mehr detailliert beschrieben.

Blockpfeile

Dieses Werkzeug bietet die in Abbildung 15 gezeigten Formen an.

Fast alle Formen besitzen Griffe, manche sogar drei. Es werden nur noch Besonderheiten explizit 
beschrieben.

Abbildung 15: Das Werkzeug "Blockpfeile"

• Die ersten sechs Formen besitzen jeweils einen Griff, der es erlaubt, sowohl die Breite des 
Pfeilbalkens wie auch die Länge des Pfeilkopfes zu ändern.

• Pfeil im Kreis: Der linke Griff erlaubt die Bestimmung des Endes des Pfeilbalkens (der hier 
natürlich ein Ringsegment ist), der rechte ermöglicht die Änderung der Position der 
Pfeilspitze sowie der Breite des Pfeilbalkens. Wenn die Pfeilspitze das Ende des Balkens 
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überlagert, ergibt sich der normalerweise hier unerwünschte Effekt, der beim Kombinieren 
zweier Formen (s. Kapitel 5 – Behandlung mehrerer Objekte dieses Handbuchs) entsteht.

• Pfeil in alle Richtungen; Pfeil nach oben, rechts und unten; Doppelpfeil oben-rechts: Der 
obere Griff verbreitert die Pfeilköpfe, der untere ändert wie bei den sechs ersten relativ 
einfachen Pfeilformen sowohl die die Breite des Pfeilbalkens als auch die Länge des 
Pfeilkopfes.

• Beide Richtungspfeile: der Griff verändert den Winkel der Spitze.

• Gestreifter Pfeil nach rechts: wie bei den einfachen Pfeilen kann die Breite Pfeilbalkens wie
auch die Länge des Pfeilkopfes verändert werden.

• Eingekerbter Pfeil nach rechts: zusätzlich zur Funktion bei den ersten Pfeilen wird auch die 
Einkerbung am Ende beeinflusst.

• Legende mit Pfeil…: Hier gibt es zusätzlich zu dem von den ersten Pfeilen bekannten Griff, 
der die Breite des Pfeilbalkens und die Länge des Pfeilkopfes bestimmt, einen Griff, der die
Breite des Pfeilkopfes festlegt (die ja nicht mehr durch die Gesamthöhe oder -breite der 
Form bestimmbar ist), und einen Griff, der das Breitenverhältnis zwischen Pfeil und 
Legendenblock regelt.

Flussdiagramme

Das Werkzeug bietet die Symbole an, die für Flussdiagramme benötigt werden. Keines der Sym-
bole besitzt zusätzliche Griffe, so dass es sich nicht lohnt, sie hier genauer zu beschreiben, die 
Direkthilfe beim Zeigen auf ein Symbol liefert bereits die nötige Information.

Legenden

Die ersten vier Formen besitzen je einen Griff, mit dem der Zeiger der Legende dem zu beschrei-
benden Objekt zugeordnet werden kann. Die anderen drei besitzen einen zweiten Griff, mit dem 
die Position der Legende nachträglich verändert werden kann, wenn der Bezug zum zu 
beschreibenden Objekt bereits fixiert ist; zwischen „Legende mit Linie 1“ und „Legende mit Linie 3“ 
lässt sich kein Unterschied feststellen. „Legende mit Linie 2“ besitzt eine geknickte Linie, deren 
Knickpunkt sich mit dem dritten Griff verschieben lässt.

Sterne und Banner

Dieses Werkzeug bietet spezielle Formen an, deren Handhabung nichts Neues im Vergleich zu 
dem bereits Gesagten bietet.

3D-Objekte

Mit diesem Werkzeug erzeugen Sie Objekte, die dreidimensionales Verhalten darstellen. Es wird 
dazu intern eine sogenannte 3D-Szene erstellt, die tatsächlich eine dreidimensionale Beschrei-
bung des Objekts enthält. Von diesem dreidimensionalen Objekt wird eine zweidimensionale Pro-
jektion auf die Ansichtsebene erstellt und in das begrenzende Rechteck eingepasst. Die Objekt-
punkte dieses projizierten Objekts erlauben eine Drehung im Raum des Objekts, Einzelheiten 
finden Sie im Kapitel 7 – Dreidimensionale Objekte dieses Handbuchs.
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Text für Formen

Allen Formen können Sie einen Text zuweisen. Das ist die bequemste und sicherste Variante der 
Gestaltung einer Zeichnung, da dann der Text immer mit der Form verknüpft ist. In manchen Fällen
müssen Sie allerdings auch den Text getrennt von der Form in einem eigenen Objekt eingeben, für
das Sie allerdings dann Sorge tragen müssen, dass es passend zum referenzierten Objekt 
platziert bleibt, beispielsweise durch Gruppieren (s. Kapitel 5 – Behandlung mehrerer Objekte 
dieses Handbuchs).

Um einem Objekt Text zuzuweisen, wählen Sie es aus und tippen einfach den gewünschten Text. 
Wenn Sie einen bereits vorhandenen Text nur am Ende ergänzen wollen, gehen Sie genauso vor.

Wenn Sie einen bestehenden Text anderweitig ändern wollen, haben Sie mehrere Möglichkeiten:

• Doppelklicken Sie das Objekt

• Betätigen Sie bei ausgewähltem Objekt F2.

• Wenn die Schnellbearbeitung zugelassen ist (Extras ► Optionen... ► LibreOffice Draw 
► Allgemein ► Schnellbearbeitung), dann ändert sich das Maussymbol zum Textcursor, 
wenn Sie auf den Text zeigen. Wenn Sie nun klicken, wird der Textcursor an der Stelle des 
Klicks positioniert.

Wie Sie den Text eines Zeichnungsobjekts formatieren können, wird im Kapitel 9 – Hinzufügen und
Formatieren von Text dieses Handbuchs beschrieben, das auch die weiteren Möglichkeiten zur 
Verwendung von Texten beschreibt.
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